
Chapter 5

One Way ANOVA

5.1 Introduction

Definition 5.1. Models in which the response variable Y is quantitative,
but all of the predictor variables are qualitative are called analysis of vari-
ance (ANOVA) models, experimental design models or design of experiments
(DOE) models. Each combination of the levels of the predictors gives a dif-
ferent distribution for Y . A predictor variable W is often called a factor and
a factor level ai is one of the categories W can take.

Definition 5.2. A lurking variable is not one of the variables in the
study, but may affect the relationships among the variables in the study.
A unit is the experimental material assigned treatments, which are the
conditions the investigator wants to study. The unit is experimental if it was
randomly assigned to a treatment, and the unit is observational if it was not
randomly assigned to a treatment.

Definition 5.3. In an experiment, the investigators use randomiza-
tion to assign treatments to units. To assign p treatments to n = n1+· · ·+np

experimental units, draw a random permutation of {1, ..., n}. Assign the first
n1 units treatment 1, the next n2 units treatment 2, ..., and the final np units
treatment p.

Randomization allows one to do valid inference such as F tests of hypothe-
ses and confidence intervals. Randomization also washes out the effects of
lurking variables and makes the p treatment groups similar except for the
treatment. The effects of lurking variables are present in observational stud-
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ies defined in Definition 5.4.

Definition 5.4. In an observational study, investigators simply ob-
serve the response, and the treatment groups need to be p random samples
from p populations (the levels) for valid inference.

Example 5.1. Consider using randomization to assign the following nine
people (units) to three treatment groups.

Carroll, Collin, Crawford, Halverson, Lawes,
Stach, Wayman, Wenslow, Xumong

Balanced designs have the group sizes the same: ni ≡ m = n/p. Label
the units alphabetically so Carroll gets 1, ..., Xumong gets 9. The R/Splus
function sample can be used to draw a random permutation. Then the first
3 numbers in the permutation correspond to group 1, the next 3 to group 2
and the final 3 to group 3. Using the output shown below, gives the following
3 groups.

group 1: Stach, Wayman, Xumong
group 2: Lawes, Carroll, Halverson
group 3: Collin, Wenslow, Crawford

> sample(9)

[1] 6 7 9 5 1 4 2 8 3

Often there is a table or computer file of units and related measurements,
and it is desired to add the unit’s group to the end of the table. The regpack
function rand reports a random permutation and the quantity groups[i] =
treatment group for the ith person on the list. Since persons 6, 7 and 9 are in
group 1, groups[7] = 1. Since Carroll is person 1 and is in group 2, groups[1]
= 2, et cetera.

> rand(9,3)

$perm

[1] 6 7 9 5 1 4 2 8 3

$groups

[1] 2 3 3 2 2 1 1 3 1
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Definition 5.5. Replication means that for each treatment, the ni

response variables Yi,1, ..., Yi,ni are approximately iid random variables.

Example 5.2. a) If ten students work two types of paper mazes three
times each, then there are 60 measurements that are not replicates. Each
student should work the six mazes in random order since speed increases
with practice. For the ith student, let Zi1 be the average time to complete
the three mazes of type 1, let Zi2 be the average time for mazes of type 2
and let Di = Zi1 − Zi2. Then D1, ..., D10 are replicates.

b) Cobb (1998, p. 126) states that a student wanted to know if the shapes
of sponge cells depends on the color (green or white). He measured hundreds
of cells from one white sponge and hundreds of cells from one green sponge.
There were only two units so n1 = 1 and n2 = 1. The student should have
used a sample of n1 green sponges and a sample of n2 white sponges to get
more replicates.

c) Replication depends on the goals of the study. Box, Hunter and Hunter
(2005, p. 215-219) describes an experiment where the investigator times how
long it takes him to bike up a hill. Since the investigator is only interested in
his performance, each run up a hill is a replicate (the time for the ith run is a
sample from all possible runs up the hill by the investigator). If the interest
had been on the effect of eight treatment levels on student bicyclists, then
replication would need n = n1 + · · · + n8 student volunteers where ni ride
their bike up the hill under the conditions of treatment i.

5.2 Fixed Effects One Way ANOVA

Definition 5.6. Let fZ(z) be the pdf of Z. Then the family of pdfs fY (y) =
fZ(y−μ) indexed by the location parameter μ, −∞ < μ < ∞, is the location
family for the random variable Y = μ + Z with standard pdf fZ(z).

Definition 5.7. A one way fixed effects ANOVA model has a single
qualitative predictor variable W with p categories a1, ..., ap. There are p
different distributions for Y , one for each category ai. The distribution of

Y |(W = ai) ∼ fZ(y − μi)

where the location family has second moments. Hence all p distributions
come from the same location family with different location parameter μi and
the same variance σ2.
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Definition 5.8. The one way fixed effects normal ANOVA model is the
special case where

Y |(W = ai) ∼ N(μi, σ
2).

Example 5.3. The pooled 2 sample t–test is a special case of a one
way ANOVA model with p = 2. For example, one population could be ACT
scores for men and the second population ACT scores for women. Then W =
gender and Y = score.

Notation. It is convenient to relabel the response variable Y1, ..., Yn as
the vector Y = (Y11, ..., Y1,n1, Y21, ..., Y2,n2, ..., Yp1, ..., Yp,np)

T where the Yij are
independent and Yi1, ..., Yi,ni are iid. Here j = 1, ..., ni where ni is the number
of cases from the ith level where i = 1, ..., p. Thus n1+· · ·+np = n. Similarly
use double subscripts on the errors. Then there will be many equivalent
parameterizations of the one way fixed effects ANOVA model.

Definition 5.9. The cell means model is the parameterization of the one
way fixed effects ANOVA model such that

Yij = μi + eij

where Yij is the value of the response variable for the jth trial of the ith
factor level. The μi are the unknown means and E(Yij) = μi. The eij are
iid from the location family with pdf fZ(z) and unknown variance σ2 =
VAR(Yij) = VAR(eij). For the normal cell means model, the eij are iid
N(0, σ2) for i = 1, ..., p and j = 1, ..., ni.

The cell means model is a linear model (without intercept) of the form
Y = Xcβc + e =⎡

⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

Y11
...

Y1,n1

Y21
...

Y2,n2

...
Yp,1
...

Yp,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

=

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

1 0 0 . . . 0
...

...
...

...
1 0 0 . . . 0
0 1 0 . . . 0
...

...
...

...
0 1 0 . . . 0
...

...
...

...
0 0 0 . . . 1
...

...
...

...
0 0 0 . . . 1

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

⎡
⎢⎢⎢⎣

μ1

μ2
...

μp

⎤
⎥⎥⎥⎦+

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

e11
...

e1,n1

e21
...

e2,n2

...
ep,1
...

ep,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

. (5.1)
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Notation. Let Yi0 =
∑ni

j=1 Yij and let

μ̂i = Y i0 = Yi0/ni =
1

ni

ni∑
j=1

Yij. (5.2)

Hence the “dot notation” means sum over the subscript corresponding to the
0, eg j. Similarly, Y00 =

∑p
i=1

∑ni

j=1 Yij is the sum of all of the Yij.

Notice that the indicator variables used in the cell means model (5.1) are
xi

h = 1 if the hth case has W = ai, and xi
h = 0, otherwise, for i = 1, ..., p

and h = 1, ..., n. So Yij has xi
h = 1 where j = 1, ..., ni. The model can use p

indicator variables for the factor instead of p− 1 indicator variables because
the model does not contain an intercept. Also notice that

E(Y ) = Xcβc = (μ1, ..., μ1, μ2, ..., μ2, ..., μp, ..., μp)
T ,

(XT
c Xc) = diag(n1, ..., np) and XT

c Y = (Y10, ..., Y10, Y20, ..., Y20, ..., Yp0, ..., Yp0)
T .

Hence (XT
c Xc)

−1 = diag(1/n1, ..., 1/np) and the OLS estimator

β̂c = (XT
c Xc)

−1XT
c Y = (Y 10, ..., Y p0)

T = (μ̂1, ..., μ̂p)
T .

Thus Ŷ = Xcβ̂c = (Y 10, ..., Y 10, ..., Y p0, ..., Y p0)
T . Hence the ijth fitted value

is
Ŷij = Y i0 = μ̂i (5.3)

and the ijth residual is

rij = Yij − Ŷij = Yij − μ̂i. (5.4)

Since the cell means model is a linear model, there is an associated re-
sponse plot and residual plot. However, many of the interpretations of the
OLS quantities for ANOVA models differ from the interpretations for MLR
models. First, for MLR models with continuous predictors x, the conditional
distribution Y |x makes sense even if x is not one of the observed xi if x is
not far from the xi. This fact makes MLR very powerful. For the one way
fixed effects ANOVA model, the p distributions Y |xi make sense where xi is
a column of Xc.

Also, the OLS MLR ANOVA F test for the cell means model tests H0 :
β = 0 ≡ H0 : μ1 = · · · = μp = 0, while the one way fixed effects ANOVA F
test given after Definition 5.13 tests H0 : μ1 = · · · = μp.
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Definition 5.10. Consider the one way fixed effects ANOVA model. The
response plot is a plot of Ŷij ≡ μ̂i versus Yij and the residual plot is a plot of

Ŷij ≡ μ̂i versus rij .

The points in the response plot scatter about the identity line and the
points in the residual plot scatter about the r = 0 line, but the scatter need
not be in an evenly populated band. A dot plot of Z1, ..., Zm consists of an
axis and m points each corresponding to the value of Zi. The response plot
consists of p dot plots, one for each value of μ̂i. The dot plot corresponding
to μ̂i is the dot plot of Yi1, ..., Yi,ni. The p dot plots should have roughly the
same amount of spread, and each μ̂i corresponds to level ai. If a new level
af corresponding to xf was of interest, hopefully the points in the response
plot corresponding to af would form a dot plot at μ̂f similar in spread to
the other dot plots, but it may not be possible to predict the value of μ̂f .
Similarly, the residual plot consists of p dot plots, and the plot corresponding
to μ̂i is the dot plot of ri1, ..., ri,ni.

Assume that each ni ≥ 10. Under the assumption that the Yij are from
the same location scale family with different parameters μi, each of the p
dot plots should have roughly the same shape and spread. This assumption
is easier to judge with the residual plot. If the response plot looks like the
residual plot, then a horizontal line fits the p dot plots about as well as the
identity line, and there is not much difference in the μi. If the identity line is
clearly superior to any horizontal line, then at least some of the means differ.

Definition 5.11. An outlier corresponds to a case that is far from the
bulk of the data. Look for a large vertical distance of the plotted point from
the identity line or the r = 0 line.

Rule of thumb 5.1. Mentally add 2 lines parallel to the identity line
and 2 lines parallel to the r = 0 line that cover most of the cases. Then a
case is an outlier if it is well beyond these 2 lines.

This rule often fails for large outliers since often the identity line goes
through or near a large outlier so its residual is near zero. A response that is
far from the bulk of the data in the response plot is a “large outlier” (large
in magnitude). Look for a large gap between the bulk of the data and the
large outlier.

Suppose there is a dot plot of nj cases corresponding to level aj that is
far from the bulk of the data. This dot plot is probably not a cluster of “bad
outliers” if nj ≥ 4 and n ≤ 50. If nj = 1, such a case may be a large outlier.
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Rule of thumb 5.2. Often an outlier is very good, but more often an
outlier is due to a measurement error and is very bad.

The assumption of the Yij coming from the same location scale family
with different location parameters μi and the same constant variance σ2

is a big assumption and often does not hold. Another way to check this
assumption is to make a box plot of the Yij for each i. The box in the box
plot corresponds to the lower, middle and upper quartiles of the Yij . The
middle quartile is just the sample median of the data mij: at least half of the
Yij ≥ mij and at least half of the Yij ≤ mij. The p boxes should be roughly
the same length and the median should occur in roughly the same position
(eg in the center of each box). The “whiskers” in each plot should also be
roughly similar. Histograms for each of the p samples could also be made.
All of the histograms should look similar in shape.

Example 5.4. Kuehl (1994, p. 128) gives data for counts of hermit crabs
on 25 different transects in each of six different coastline habitats. Let Z be
the count. Then the response variable Y = log10(Z + 1/6). Although the
counts Z varied greatly, each habitat had several counts of 0 and often there
were several counts of 1, 2 or 3. Hence Y is not a continuous variable. The
cell means model was fit with ni = 25 for i = 1, ..., 6. Each of the six habitats
was a level. Figure 5.1a and b shows the response plot and residual plot.
There are 6 dot plots in each plot. Because several of the smallest values in
each plot are identical, it does not always look like the identity line is passing
through the six sample means Y i0 for i = 1, ..., 6. In particular, examine the
dot plot for the smallest mean (look at the 25 dots furthest to the left that
fall on the vertical line FIT ≈ 0.36). Random noise (jitter) has been added to
the response and residuals in Figure 5.1c and d. Now it is easier to compare
the six dot plots. They seem to have roughly the same spread.

The plots contain a great deal of information. The response plot can be
used to explain the model, check that the sample from each population (treat-
ment) has roughly the same shape and spread, and to see which populations
have similar means. Since the response plot closely resembles the residual
plot in Figure 5.1, there may not be much difference in the six populations.
Linearity seems reasonable since the samples scatter about the identity line.
The residual plot makes the comparison of “similar shape” and “spread”
easier.
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Figure 5.1: Plots for Crab Data

Definition 5.12. a) The total sum of squares

SSTO =

p∑
i=1

ni∑
j=1

(Yij − Y 00)
2.

b) The treatment sum of squares

SSTR =

p∑
i=1

ni(Y i0 − Y 00)
2.

c) The residual sum of squares or error sum of squares

SSE =

p∑
i=1

ni∑
j=1

(Yij − Y io)
2.

Definition 5.13. Associated with each SS in Definition 5.12 is a degrees
of freedom (df) and a mean square = SS/df. For SSTO, df = n − 1 and
MSTO = SSTO/(n−1). For SSTR, df = p−1 and MSTR = SSR/(p−1).
For SSE, df = n − p and MSE = SSE/(n − p).

Let S2
i =

∑ni

j=1(Yij − Y i0)
2/(ni − 1) be the sample variance of the ith

group. Then the MSE is a weighted sum of the S2
i :

σ̂2 = MSE =
1

n − p

p∑
i=1

ni∑
j=1

r2
ij =

1

n − p

p∑
i=1

ni∑
j=1

(Yij − Y i0)
2 =
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1

n − p

p∑
i=1

(ni − 1)S2
i = S2

pool

where S2
pool is known as the pooled variance estimator.

The ANOVA table is the same as that for MLR, except that SSTR re-
places the regression sum of squares. The MSE is again an estimator of σ2.
The ANOVA F test tests whether all p means μi are equal. Shown below is
an ANOVA table given in symbols. Sometimes “Treatment” is replaced by
“Between treatments,” “Between Groups,” “Model,” “Factor” or “Groups.”
Sometimes “Error” is replaced by “Residual,” or “Within Groups.” Some-
times “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

Summary Analysis of Variance Table

Source df SS MS F p-value
Treatment p-1 SSTR MSTR Fo=MSTR/MSE for Ho:

Error n-p SSE MSE μ1 = · · · = μp

Be able to perform the 4 step fixed effects one way ANOVA F
test of hypotheses:
i) State the hypotheses Ho: μ1 = μ2 = · · · = μp and Ha: not Ho.
ii) Find the test statistic Fo = MSTR/MSE or obtain it from output.
iii) Find the p–value from output or use the F–table: p–value =

P (Fp−1,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If the p–value < δ, reject
Ho and conclude that the mean response depends on the factor. Otherwise
fail to reject Ho and conclude that the mean response does not depend on
the factor. Give a nontechnical sentence.

Rule of thumb 5.3. If

max(S1, ..., Sp) ≤ 2min(S1, ..., Sp),

then the one way ANOVA F test results will be approximately correct if
the response and residual plots suggest that the remaining one way ANOVA
model assumptions are reasonable. See Moore (1999, p. 512).

Remark 5.1. If the units are a representative sample of some population
of interest, then randomization of units into groups makes the assumption
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that Yi1, ..., Yi,ni are iid hold to a useful approximation. Random sampling
from populations also induces the iid assumption. Linearity can be checked
with the response plot, and similar shape and spread of the location families
can be checked with both the response and residual plots. Also check that
outliers are not present. If the p dot plots in the response plot are approx-
imately symmetric, then the sample sizes ni can be smaller than if the dot
plots are skewed.

Remark 5.2. When the assumption that the p groups come from the
same location family with finite variance σ2 is violated, the one way ANOVA
F test may not make much sense because unequal means may not imply the
superiority of one category over another. Suppose Y is the time in minutes
until relief from a headache and that Y1j ∼ N(60, 1) while Y2j ∼ N(65, σ2).
If σ2 = 1, then the type 1 medicine gives headache relief 5 minutes faster, on
average, and is superior, all other things being equal. But if σ2 = 100, then
many patients taking medicine 2 experience much faster pain relief than those
taking medicine 1, and many experience much longer time until pain relief.
In this situation, predictor variables that would identify which medicine is
faster for a given patient would be very useful.

fat1 fat2 fat3 fat4 One way Anova for Fat1 Fat2 Fat3 Fat4

64 78 75 55 Source DF SS MS F P

72 91 93 66 treatment 3 1636.5 545.5 5.41 0.0069

68 97 78 49 error 20 2018.0 100.9

77 82 71 64

56 85 63 70

95 77 76 68

Example 5.5. The output above represents grams of fat (minus 100
grams) absorbed by doughnuts using 4 types of fat. See Snedecor and
Cochran (1967, p. 259). Let μi denote the mean amount of fati absorbed by
doughnuts, i = 1, 2, 3 and 4. a) Find μ̂1. b) Perform a 4 step Anova F test.

Solution: a) β̂1c = μ̂1 = Y 10 = Y10/n1 =
∑n1

j=1 Y1j/n1 =
(64 + 72 + 68 + 77 + 56 + 95)/6 = 432/6 = 72.

b) i) H0 : μ1 = μ2 = μ3 = μ4 Ha: not H0

ii) F = 5.41
iii) pvalue = 0.0069
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iv) Reject H0, the mean amount of fat absorbed by doughnuts depends
on the type of fat.

Definition 5.14. A contrast C =
∑p

i=1 kiμi where
∑p

i=1 ki = 0. The

estimated contrast is Ĉ =
∑p

i=1 kiY i0.

If the null hypothesis of the fixed effects one way ANOVA test is not
true, then not all of the means μi are equal. Researchers will often have
hypotheses, before examining the data, that they desire to test. Often such
a hypothesis can be put in the form of a contrast. For example, the contrast
C = μi−μj is used to compare the means of the ith and jth groups while the
contrast μ1 − (μ2 + · · ·+μp)/(p− 1) is used to compare the last p− 1 groups
with the 1st group. This contrast is useful when the 1st group corresponds to
a new treatment while the remaining groups correspond to new treatments.

Assume that the normal cell means model is a useful approximation to
the data. Then the Y i0 ∼ N(μi, σ

2/ni) are independent, and

Ĉ =

p∑
i=1

kiY i0 ∼ N

(
C, σ2

p∑
i=1

k2
i

ni

)
.

Hence the standard error

SE(Ĉ) =

√√√√MSE

p∑
i=1

k2
i

ni
.

The degrees of freedom is equal to the MSE degrees of freedom = n − p.
Consider a family of null hypotheses for contrasts {Ho :

∑p
i=1 kiμi = 0

where
∑p

i=1 ki = 0 and the ki may satisfy other constraints}. Let δS denote
the probability of a type I error for a single test from the family where a type
I error is a false rejection. The family level δF is an upper bound on the
(usually unknown) size δT . Know how to interpret δF ≈ δT =
P(of making at least one type I error among the family of contrasts).

Two important families of contrasts are the family of all possible con-
trasts and the family of pairwise differences Cij = μi − μj where i �= j. The
Scheffé multiple comparisons procedure has a δF for the family of all possible
contrasts while the Tukey multiple comparisons procedure has a δF for the
family of all

(
p
2

)
pairwise contrasts.

To interpret output for multiple comparisons procedures, the underlined
means or blocks of letters besides groups of means indicate that the group
of means are not significantly different.
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Example 5.6. The output below uses data from SAS Institute (1985,
p. 126-129). The mean nitrogen content of clover depends on the strain of
clover (3dok1, 3dok5, 3dok7, compos, 3dok4, 3dok13). Recall that means
μ1 and μ2 are significantly different if you can conclude that μ1 �= μ2 while
μ1 and μ2 are not significantly different if there is not enough evidence to
conclude that μ1 �= μ2 (perhaps because the means are approximately equal
or perhaps because the sample sizes are not large enough).

Notice that the strain of clover 3dok1 appears to have the highest mean
nitrogen content. There are 4 pairs of means that are not significantly differ-
ent. The letter B suggests 3dok5 and 3dok7, the letter C suggests 3dok7 and
compos, the letter D suggests compos and 3dok4, while the letter E suggests
3dok4 and 3dok13 are not significantly different.

Means with the same letter are not significantly different.

Waller Grouping Mean N strain

A 28.820 5 3dok1

B 23.980 5 3dok5

B

C B 19.920 5 3dok7

C

C D 18.700 5 compos

D

E D 14.640 5 3dok4

E

E 13.260 5 3dok13

Definition 5.15. Graphical Anova for the one way model uses the
residuals as a reference set instead of a t, F or normal distribution. The
scaled treatment deviations or scaled effect c(Y i − Y 00) = c(μ̂i − Y 00) are
scaled to have the same variability as the residuals. A dot plot of the
scaled deviations is placed above the dot plot of the residuals. Assume that
ni ≡ m = n/p for i = 1, ..., p. For small n ≤ 40, suppose the distance be-
tween two scaled deviations (A and B, say) is greater than the range of the
residuals = max(rij)−min(rij). Then declare μA and μB to be significantly
different. If the distance is less than the range, do not declare μA and μB to
be significantly different. Scaled deviations that lie outside the range of the
residuals are significant.
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Figure 5.2: Graphical Anova

For n ≥ 100, let r(1) ≤ r(2) ≤ · · · ≤ r(n) be the order statistics of the resid-
uals. Then instead of the range, use r(�0.975n�)−r(�0.025n�) as the distance where
	x
 is the smallest integer ≥ x, eg 	7.7
 = 8. So effects outside of the interval
(r(�0.025n�), r(�0.975n�)) are significant. See Box, Hunter and Hunter (2005, p.

136, 166). A derivation of the scaling constant c =
√

(n − p)/(p − 1) is given
in Section 5.6.

ganova(x,y)

sdev 0.02955502 0.06611268 -0.05080048 -0.04486722

Treatments "A" "B" "C" "D"

Example 5.7. Cobb (1998, p. 160) describes a one way Anova design
used to study the amount of calcium in the blood. For many animals, the
body’s ability to use calcium depends on the level of certain hormones in
the blood. The response was 1/(level of plasma calcium). The four groups
were A: Female controls, B: Male controls, C: Females given hormone and
D: Males given hormone. There were 10 birds of each gender, and five from
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each gender were given the hormone. The output above uses the regpack

function ganova to produce Figure 5.2.
In Figure 5.2, the top dot plot has the scaled treatment deviations. From

left to right, these correspond to C, D, A and B since the output shows that
the deviation corresponding to C is the smallest with value −0.050. Since the
deviations corresponding to C and D are much closer than the range of the
residuals, the C and D effects yielded similar mean response values. A and
B appear to be significantly different from C and D. The distance between
the scaled A and B treatment deviations is about the same as the distance
between the smallest and largest residuals, so there is only marginal evidence
that the A and B effects are significantly different.

Since all 4 scaled deviations lie outside of the range of the residuals, all
effects A, B, C and D appear to be significant.

5.3 Random Effects One Way ANOVA

Definition 5.16. For the random effects one way Anova, the levels of
the factor are a random sample of levels from some population of levels ΛF .
The cell means model for the random effects one way Anova is Yij = μi + eij

for i = 1, ..., p and j = 1, ..., ni. The μi are randomly selected from some
population Λ with mean μ and variance σ2

μ, where i ∈ ΛF is equivalent to
μi ∈ Λ. The eij and μi are independent, and the eij are iid from a location
family with pdf f , mean 0 and variance σ2. The Yij|μi ∼ f(y − μi), where
the pdf f is a location family with variance σ2. Unconditionally, E(Yij) = μ
and V (Yij) = σ2

μ + σ2.

For the random effects model, the μi are independent random variables
with E(μi) = μ and V (μi) = σ2

μ. The cell means model for fixed effects one
way Anova is very similar to that for the random effects model, but the μi

are fixed constants rather than random variables.

Definition 5.17. For the normal random effects one way Anova model,
Λ ∼ N(μ, σ2

μ). Thus the μi are independent N(μ, σ2
μ) random variables. The

eij are iid N(0, σ2) and the eij and μi are independent. For this model,
Yij|μi ∼ N(μi, σ

2) for i = 1, ..., p. Note that the conditional variance σ2 is
the same for each μi ∈ Λ. Unconditionally, Yij ∼ N(μ, σ2

μ + σ2).

The fixed effects one way Anova tested Ho : μ1 = · · · = μp. For the
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random effects one way Anova, interest is in whether μi ≡ μ for every μi in
Λ where the population Λ is not necessarily finite. Note that if σ2

μ = 0, then
μi ≡ μ for all μi ∈ Λ. In the sample of p levels, the μi will differ if σ2

μ > 0.

Be able to perform the 4 step random effects one way ANOVA
F test of hypotheses:
i) Ho : σ2

μ = 0 Ha : σ2
μ > 0

ii) Fo = MSTR/MSE is usually obtained from output.
iii) The p-value = P (Fp−1,n−p > Fo) is usually obtained from output.
iv) If p–value < δ reject Ho, conclude that σ2

μ > 0 and that the mean response
depends on the factor. Otherwise, fail to reject Ho, conclude that σ2

μ = 0
and that the mean response does not depend on the factor.

The ANOVA tables for the fixed and random effects one way Anova mod-
els are exactly the same, and the two F tests are very similar. The main
difference is that the conclusions for the random effects model can be gen-
eralized to the entire population of levels. For the fixed effects model, the
conclusions only hold for the p fixed levels. If Ho : σ2

μ = 0 is true and the
random effect model holds, then the Yij are iid with pdf f(y − μ). So the F
statistic for the random effects test has an approximate Fp−1,n−p distribution
if the ni are large by the results for the fixed effects one way Anova test. For
both tests, the output p-value is an estimate of the population p-value.

Source df SS MS F P

brand 5 854.53 170.906 238.71 0.0000

error 42 30.07 0.716

Example 5.8. Data is from Neter, Kutner, Nachtsheim and Wasserman
(1996, problem 24.7). A researcher is interested in the amount of sodium
in beer. She selects 6 brands of beer at random from 127 brands and the
response is the average sodium content measured from 8 cans of each brand.

a) State whether this is a random or fixed effects one way Anova. Explain
briefly.

b) Using the output above, perform the appropriate 4 step Anova F test.

Solution: a) Random effects since the beer brands were selected at random
from a population of brands.

b) i) H0 : σ2
μ = 0 Ha : σ2

μ > 0
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ii) F0 = 238.71
iii) pvalue = 0.0
iv) Reject H0, so σ2

μ > 0 and the mean amount of sodium depends on the
beer brand.

Remark 5.3. The response and residual plots for the random effects
models are interpreted in the same way as for the fixed effects model, except
that the dot plots are from a random sample of p levels instead of from p
fixed levels.

5.4 Response Transformations for Experimen-

tal Design

A model for an experimental design is Yi = E(Yi) + ei for i = 1, ..., n where
the error ei = Yi − E(Yi) and E(Yi) ≡ E(Yi|xi) is the expected value of the
response Yi for a given vector of predictors xi. Many models can be fit with
least squares (OLS or LS) and are linear models of the form

Yi = xi,1β1 + xi,2β2 + · · · + xi,pβp + ei = xT
i β + ei

for i = 1, . . . , n. Often xi,1 ≡ 1 for all i. In matrix notation, these n equations
become

Y = Xβ + e,

where Y is an n × 1 vector of dependent variables, X is an n × p design
matrix of predictors, β is a p × 1 vector of unknown coefficients, and e is
an n × 1 vector of unknown errors. If the fitted values are Ŷi = xT

i β̂, then
Yi = Ŷi + ri where the residuals ri = Yi − Ŷi.

The applicability of an experimental design model can be expanded by
allowing response transformations. An important class of response transfor-
mation models adds an additional unknown transformation parameter λo,
such that

Yi = tλo(Zi) ≡ Z
(λo)
i = E(Yi) + ei = xT

i β + ei.

If λo was known, then Yi = tλo(Zi) would follow the linear model for the
experimental design.

Definition 5.18. Assume that all of the values of the “response” Zi are
positive. A power transformation has the form Y = tλ(Z) = Zλ for λ �= 0
and Y = t0(Z) = log(Z) for λ = 0 where λ ∈ ΛL = {−1,−1/2, 0, 1/2, 1}.
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Figure 5.3: Transformation Plots for Crab Data

A graphical method for response transformations computes the fitted val-
ues Ŵi from the experimental design model using Wi = tλ(Zi) as the “re-
sponse.” Then a plot of the Ŵ versus W is made for each of the five values
of λ ∈ ΛL. The plotted points follow the identity line in a (roughly) evenly
populated band if the experimental design model is reasonable for (Ŵ , W ).
If more than one value of λ ∈ ΛL gives a linear plot, consult subject matter
experts and use the simplest or most reasonable transformation. Note that
ΛL has 5 models, and the graphical method selects the model with the best
response plot. After selecting the transformation, the usual checks should be
made. In particular, the transformation plot is also the response plot, and a
residual plot should be made.

Definition 5.19. A transformation plot is a plot of (Ŵ , W ) with the
identity line added as a visual aid.

In the following example, the plots show tλ(Z) on the vertical axis. The
label “TZHAT” of the horizontal axis are the fitted values that result from
using tλ(Z) as the “response” in the software.

For one way Anova models with ni ≡ m ≥ 5, look for a transformation
plot that satisfies the following conditions. i) The p dot plots scatter about
the identity line with similar shape and spread. ii) Dot plots with more skew
are worse than dot plots with less skew or dot plots that are approximately
symmetric. iii) Spread that increases or decreases with TZHAT is bad.

200



Example 5.4, continued. Following Kuehl (1994, p. 128), let C be
the count of crabs and let the “response” Z = C + 1/6. Figure 5.3 shows
the five transformation plots. The transformation log(Z) results in dot plots
that have roughly the same shape and spread. The transformations 1/Z and
1/
√

Z do not handle the 0 counts well, while the transformations
√

Z and Z
have variance that increases with the mean.

Remark 5.4. The graphical method for response transformations can
be used for design models that are linear models, not just one way Anova
models. The method is nearly identical to that of Chapter 3, but ΛL only has

5 values. The log rule states that if all of the Zi > 0 and if
max(Zi)

min(Zi)
≥ 10,

then the response transformation Y = log(Z) will often work.

5.5 Summary

1) The fixed effects one way Anova model has one qualitative explanatory
variable called a factor and a quantitative response variable Yij . The factor
variable has p levels, E(Yij) = μi and V (Yij) = σ2 for i = 1, ..., p and
j = 1, ..., ni. Experimental units are randomly assigned to the treatment
levels.

2) In an experiment, the investigators assign treatments to experimen-
tal units. In an observational study, investigators simply observe the
response.

3) Let n = n1+· · ·+np. In an experiment, the investigators use random-
ization to randomly assign n units to treatments. Draw a random permuta-
tion of {1, ..., n}. Assign the first n1 units to treatment 1, the next n2 units
to treatment 2, ..., and the final np units to treatment p. Use ni ≡ m = n/p
if possible. Randomization washes out the effect of lurking variables.

4) The 4 step fixed effects one way Anova F test has steps
i) Ho: μ1 = μ2 = · · · = μp and Ha: not Ho.
ii) Fo = MSTR/MSE is usually given by output.
iii) The p-value = P(Fp−1,n−p > Fo) is usually given by output.
iv) If the p–value < δ, reject Ho and conclude that the mean response de-
pends on the factor. Otherwise fail to reject Ho and conclude that the mean
response does not depend on the factor. Give a nontechnical sentence.
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Summary Analysis of Variance Table

Source df SS MS F p-value
Treatment p-1 SSTR MSTR Fo=MSTR/MSE for Ho:

Error n-p SSE MSE μ1 = · · · = μp

5) Shown is an ANOVA table given in symbols. Sometimes “Treatment”
is replaced by “Between treatments,” “Between Groups,” “Model,” “Fac-
tor” or “Groups.” Sometimes “Error” is replaced by “Residual,” or “Within
Groups.” Sometimes “p-value” is replaced by “P”, “Pr(> F )” or “PR > F.”

6) Boxplots and dotplots for each level are useful for this test. A dot plot
of Z1, ..., Zm consists of an axis and m points each corresponding to the value
of Zi. If all of the boxplots or dotplots are about the same, then probably
the Anova F test will fail to reject Ho. If Ho is true, then Yij = μ+ εij where
the εij are iid with 0 mean and constant variance σ2. Then μ̂ = Y oo and the
factor doesn’t help predict Yij .

7) Let fZ(z) be the pdf of Z. Then the family of pdfs fY (y) = fZ(y − μ)
indexed by the location parameter μ, −∞ < μ < ∞, is the location family
for the random variable Y = μ+Z with standard pdf fZ(y). A one way fixed
effects ANOVA model has a single qualitative predictor variable W with p
categories a1, ..., ap. There are p different distributions for Y , one for each
category ai. The distribution of

Y |(W = ai) ∼ fZ(y − μi)

where the location family has second moments. Hence all p distributions
come from the same location family with different location parameter μi and
the same variance σ2. The one way fixed effects normal ANOVA model is the
special case where Y |(W = ai) ∼ N(μi, σ

2).

8) The response plot is a plot of Ŷ versus Y . For the one way Anova model,
the response plot is a plot of Ŷij = μ̂i versus Yij. Often the identity line with
unit slope and zero intercept is added as a visual aid. Vertical deviations
from the identity line are the residuals rij = Yij − Ŷij = Yij − μ̂i. The plot
will consist of p dot plots that scatter about the identity line with similar
shape and spread if the fixed effects one way ANOVA model is appropriate.
The ith dot plot is a dot plot of Yi,1, ..., Yi,ni. Assume that each ni ≥ 10. If
the response plot looks like the residual plot, then a horizontal line fits the p
dot plots about as well as the identity line, and there is not much difference
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in the μi. If the identity line is clearly superior to any horizontal line, then
at least some of the means differ.

9) The residual plot is a plot of Ŷ versus residual r = Y − Ŷ . The plot
will consist of p dot plots that scatter about the r = 0 line with similar shape
and spread if the fixed effects one way ANOVA model is appropriate. The
ith dot plot is a dot plot of ri,1, ..., ri,ni. Assume that each ni ≥ 10. Under
the assumption that the Yij are from the same location scale family with
different parameters μi, each of the p dot plots should have roughly the same
shape and spread. This assumption is easier to judge with the residual plot
than with the response plot.

10) Rule of thumb: If max(S1, ..., Sp) ≤ 2min(S1, ..., Sp), then the one
way ANOVA F test results will be approximately correct if the response and
residual plots suggest that the remaining one way ANOVA model assump-
tions are reasonable.

11) In an observational study, investigators simply observe the re-
sponse, and the treatment groups need to be p random samples from p pop-
ulations (the levels). The effects of lurking variables are present in observa-
tional studies.

12) If a qualitative variable has c levels, represent it with c − 1 or c
indicator variables. Given a qualitative variable, know how to represent the
data with indicator variables.

13) The cell means model for the fixed effects one way Anova is Yij =
μi + eij where Yij is the value of the response variable for the jth trial of the
ith factor level for i = 1, ..., p and j = 1, ..., ni. The μi are the unknown means
and E(Yij) = μi. The eij are iid from the location family with pdf fZ(z), zero
mean and unknown variance σ2 = V (Yij) = V (eij). For the normal cell means

model, the eij are iid N(0, σ2). The estimator μ̂i = Y i0 =
∑ni

j=1 Yij/ni = Ŷij.

The ith residual is rij = Yij−Y i0, and Y 00 is the sample mean of all of the Yij

and n =
∑p

i=1 ni. The total sum of squares SSTO =
∑p

i=1

∑ni

j=1(Yij − Y 00)
2,

the treatment sum of squares SSTR =
∑p

i=1 ni(Y i0 − Y 00)
2, and the error

sum of squares SSE =
∑p

i=1

∑ni

j=1(Yij − Y i0)
2. The MSE is an estimator of

σ2. The Anova table is the same as that for multiple linear regression, except
that SSTR replaces the regression sum of squares and that SSTO, SSTR and
SSE have n − 1, p − 1 and n − p degrees of freedom.
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14) Let Yi0 =
∑ni

j=1 Yij and let

μ̂i = Y i0 = Yi0/ni =
1

ni

ni∑
j=1

Yij.

Hence the “dot notation” means sum over the subscript corresponding to the
0, eg j. Similarly, Y00 =

∑p
i=1

∑ni

j=1 Yij is the sum of all of the Yij . Be able
to find μ̂i from data.

15) If the p treatment groups come from the same location family (so
μi ≡ μ) with finite variance σ2, and if the one way ANOVA F test statistic

is computed from all
n!

n1! · · ·np!
ways of assigning ni of the response variables

to treatment i, then the histogram of the F test statistic is approximately
Fp−1,n−p for large ni.

16) Graphical Anova for the one way Anova model makes a dotplot of
scaled treatment deviations (effects) above a dotplot of the residuals. Assume
the ni ≡ m for i = 1, ..., p. Then the ith scaled deviation is c(Y i0 − Y 00) =

cα̂i = α̃i where c =
√

dfe/dftreat =

√
n − p

p − 1
.

17) Know that for the random effects one way Anova, the levels of
the factor are a random sample of levels from some population of levels ΛF .
Assume the μi are iid with mean μ and variance σ2

μ. The cell means model
for the random effects one way Anova is Yij = μi + eij for i = 1, ..., p and
j = 1, ..., ni. The sample size n = n1 + · · ·+ np and often ni ≡ m so n = pm.
The μi and eij are independent. The eij have mean 0 and variance σ2. The
Yij|μi ∼ f(y − μi), a location family with variance σ2 while eij ∼ f(y). In
the test below, if H0 : σ2

μ = 0 is true, then the Yij are iid with pdf f(y − μ),
so the F statistic ≈ Fp−1,n−p if the ni are large.

18) Know that the 4 step random effects one way Anova test is
i) H0 σ2

μ = 0 HA σ2
μ > 0

ii) F0 = MSTR/MSE is usually obtained from output.
iii) The pvalue = P (Fp−1,n−p > F0) is usually obtained from output.
iv) If pvalue < δ reject Ho, conclude that σ2

μ > 0 and that the mean response
depends on the factor. Otherwise, fail to reject Ho, conclude that σ2

μ = 0
and that the mean response does not depend on the factor.

19) Know how to tell whether the experiment is a fixed or random effects
one way Anova. (Were the levels fixed or a random sample from a population
of levels?)
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20) The applicability of a DOE (design of experiments) model can be ex-
panded by allowing response transformations. An important class of response
transformation models is

Y = tλo(Z) = E(Y ) + e = xT β + e

where the subscripts (eg Yij) have been suppressed. If λo was known, then
Y = tλo(Z) would follow the DOE model. Assume that all of the values
of the “response” Z are positive. A power transformation has the form
Y = tλ(Z) = Zλ for λ �= 0 and Y = t0(Z) = log(Z) for λ = 0 where
λ ∈ ΛL = {−1,−1/2, 0, 1/2, 1}.

21) A graphical method for response transformations computes the fitted
values Ŵ from the DOE model using W = tλ(Z) as the “response” for each
of the five values of λ ∈ ΛL. Let T̂ = Ŵ = TZHAT and plot TZHAT vs
tλ(Z) for λ ∈ {−1,−1/2, 0, 1/2, 1}. These plots are called transformation
plots. The residual or error degrees of freedom used to compute the MSE
should not be too small. Choose the transformation Y = tλ∗(Z) that has the
best plot. Consider the one way Anova model with ni > 4 for i = 1, ..., p.
i) The dot plots should spread about the identity line with similar shape
and spread. ii) Dot plots that are approximately symmetric are better than
skewed dot plots. iii) Spread that increases or decreases with TZHAT (the
shape of the plotted points is similar to a right or left opening megaphone)
is bad.

22) The transformation plot for the selected transformation is also the
response plot for that model (eg for the model that uses Y = log(Z) as the
response). Make all of the usual checks on the DOE model (residual and
response plots) after selecting the response transformation.

23) The log rule says try Y = log(Z) if max(Z)/min(Z) > 10 where
Z > 0 and the subscripts have been suppressed (so Z ≡ Zij for the one way
Anova model).

24) A contrast C =
∑p

i=1 kiμi where
∑p

i=1 ki = 0. The estimated contrast

is Ĉ =
∑p

i=1 kiY i0.

25) Consider a family of null hypotheses for contrasts {Ho :
∑p

i=1 kiμi = 0
where

∑p
i=1 ki = 0 and the ki may satisfy other constraints }. Let δS denote

the probability of a type I error for a single test from the family. The family
level δF is an upper bound on the (usually unknown) size δT . Know how to
interpret δF ≈ δT = P(of making at least one type I error among the family
of contrasts) where a type I error is a false rejection.
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26) Two important families of contrasts are the family of all possible
contrasts and the family of pairwise differences Cij = μi − μj where i �= j.
The Scheffé multiple comparisons procedure has a δF for the family of all
possible contrasts while the Tukey multiple comparisons procedure has a δF

for the family of all
(

p
2

)
pairwise contrasts.

27) Know how to interpret output for multiple comparisons procedures.
Underlined means or blocks of letters besides groups of means indicates that
the group of means are not significantly different.

28) For the one way Anova, the fitted values Ŷij = Y i0 and the residuals

eij = Yij−Ŷij . Graphical Anova for the one way Anova model makes a dot-
plot of scaled treatment deviations (effects) above a dotplot of the residuals.
Scaled deviations outside of the range of the residuals may be significant.

29) The analysis of the response, not that of the residuals, is of primary
importance. The response plot can be used to analyze the response in the
background of the fitted model. For linear models such as experimental
designs, the estimated mean function is the identity line and should be added
as a visual aid.

30) Assume that the residual degrees of freedom are large enough for
testing. Then the response and residual plots contain much information.
Linearity and constant variance may be reasonable if the p dot plots have
roughly the same shape and spread, and the dot plots scatter about the
identity line. The p dot plots of the residuals should have similar shape and
spread, and the dot plots scatter about the r = 0 line. It is easier to check
linearity with the response plot and constant variance with the residual plot.
Curvature is often easier to see in a residual plot, but the response plot can
be used to check whether the curvature is monotone or not. The response
plot is more effective for determining whether the signal to noise ratio is
strong or weak, and for detecting outliers or influential cases.

5.6 Complements

Often the data does not consist of samples from p populations, but consists
of a group of n = mp units where m units are randomly assigned to each
of the p treatments. Then the ANOVA models can still be used to compare
treatments, but statistical inference to a larger population can not be made.
Of course a nonstatistical generalization to larger populations can be made.
The nonstatistical generalization from the group of units to a larger popula-
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tion is most compelling if several experiments are done with similar results.
For example, generalizing the results of an experiment for psychology stu-
dents to the population of all of the university students is less compelling
than the following generalization. Suppose one experiment is done for psy-
chology students, one for engineers and one for English majors. If all three
experiments give similar results, then generalize the results to the population
of all of the university’s students.

Four good tests on the design and analysis of experiments are Box, Hunter
and Hunter (2005), Cobb (1998), Kuehl (1994) and Ledolter and Swersey
(2007). Also see Dean and Voss (2000), Kirk (1982), Montgomery (2005)
and Oehlert (2000).

A randomization test has H0: the different treatments have no effect.
This null hypothesis is also true if all p pdfs Y |(W = ai) ∼ fZ(y − μ) are
the same. An impractical randomization test uses all M = n!

n1!···np !
ways of

assigning ni of the Yij to treatment i for i = 1, ..., p. Let F0 be the usual F
statistic. The F statistic is computed for each of the M permutations and
H0 is rejected if the proportion of the M F statistics that are larger than
F0 is less than δ. The distribution of the M F statistics is approximately
Fp−1,n−p for large n when H0 is true. The power of the randomization test is
also similar to that of the usual F test. See Hoeffding (1952). These results
suggest that the usual F test is semiparametric: the pvalue is approximately
correct if n is large and if all p pdfs Y |(W = ai) ∼ fZ(y − μ) are the same.

Olive (2009c) shows that practical randomization tests that use a random
sample of max(5000, n) permutations have level and power similar to the tests
that use all M possible permutations. See Ernst (2009) for R code.

All of the parameterizations of the one way fixed effects ANOVA model
yield the same predicted values, residuals and ANOVA F test, but the inter-
pretations of the parameters differ. The cell means model is a linear model
(without intercept) of the form Y = Xcβc + e = that can be fit using OLS.
The OLS MLR output gives the correct fitted values and residuals but an
incorrect Anova table. An equivalent linear model (with intercept) with cor-
rect OLS MLR Anova table as well as residuals and fitted values can be
formed by replacing any column of the cell means model by a column of ones
1. Removing the last column of the cell means model and making the first
column 1 gives the model Y = β0 +β1x1 + · · ·+βp−1xp−1 + e given in matrix
form by (5.5).

It can be shown that the OLS estimators corresponding to (5.5) are β̂0 =
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Y p0 = μ̂p, and β̂i = Y i0 − Y p0 = μ̂i − μ̂p for i = 1, ..., p − 1. The cell means

model has β̂i = μ̂i = Y i0.

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

Y11
...

Y1,n1

Y21
...

Y2,n2

...
Yp,1
...

Yp,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

=

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

1 1 0 . . . 0
...

...
...

...
1 1 0 . . . 0
1 0 1 . . . 0
...

...
...

...
1 0 1 . . . 0
...

...
...

...
1 0 0 . . . 1
...

...
...

...
1 0 0 . . . 1
1 0 0 . . . 0
...

...
...

...
1 0 0 . . . 0

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

⎡
⎢⎢⎢⎣

β0

β1
...

βp−1

⎤
⎥⎥⎥⎦+

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

e11
...

e1,n1

e21
...

e2,n2

...
ep,1
...

ep,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

. (5.5)

Wilcox (2005) gives an excellent discussion of the problems that outliers
and skewness can cause for the one and two sample t–intervals, the t–test,
tests for comparing 2 groups and the ANOVA F test. Wilcox (2005) replaces
ordinary population means by truncated population means and uses trimmed
means to create analogs of one way ANOVA and multiple comparisons.

Graphical Anova uses scaled treatment effects = scaled treatment de-
viations d̃i = cdi = c(Y i0 − Y 00) for i = 1, ..., p. Following Box, Hunter
and Hunter (2005, p. 166), suppose ni ≡ m = n/p for i = 1, ..., n. If Ho
μ1 = · · · = μp is true, want the sample variance of the scaled deviations
to be approximately equal to the sample variance of the residuals. So want

1 ≈
1
p

∑p
i=1 c2d2

i

1
n

∑n
i=1 r2

i

= F0 =
MSTR

MSE
=

SSTR/(p − 1)

SSE/(n − p)
=

∑p
i=1 md2

i /(p − 1)∑n
i=1 r2

i /(n − p)

since SSTR =
∑p

i=1 m(Y i0 − Y 00)
2 =

∑p
i=1 md2

i . So

F0 =

∑p
i=1 c2 n

p
d2

i∑n
i=1 r2

i

=

∑p
i=1

m(n−p)
p−1

d2
i∑n

i=1 r2
i

.

Equating numerators gives

c2 =
mp

n

(n − p)

(p − 1)
=

(n − p)

(p − 1)
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since mp/n = 1. Thus c =
√

(n − p)/(p − 1).
The modified power transformation family

Yi = tλ(Zi) ≡ Z
(λ)
i =

Zλ
i − 1

λ

for λ �= 0 and t0(Zi) = log(Zi) for λ = 0 where λ ∈ ΛL.
Box and Cox (1964) give a numerical method for selecting the response

transformation for the modified power transformations. Although the method
gives a point estimator λ̂o, often an interval of “reasonable values” is gen-
erated (either graphically or using a profile likelihood to make a confidence
interval), and λ̂ ∈ ΛL is used if it is also in the interval.

There are several reasons to use a coarse grid ΛL of powers. First, several
of the powers correspond to simple transformations such as the log, square
root, and reciprocal. These powers are easier to interpret than λ = .28,
for example. Secondly, if the estimator λ̂n can only take values in ΛL, then
sometimes λ̂n will converge in probability to λ∗ ∈ ΛL. Thirdly, Tukey (1957)
showed that neighboring modified power transformations are often very sim-
ilar, so restricting the possible powers to a coarse grid is reasonable.

The graphical method for response transformations is due to Olive (2004)
and Olive and Hawkins (2009a). A variant of the method would plot the
residual plot or both the response and the residual plot for each of the five
values of λ. Residual plots are also useful, but they do not distinguish be-
tween nonlinear monotone relationships and nonmonotone relationships. See
Fox (1991, p. 55). Alternative methods are given by Cook and Olive (2002)
and Box, Hunter and Hunter (2005, p. 321).

An alternative to one way ANOVA is to use FWLS (see Chapter 4) on
the cell means model with σ2V = diag(σ2

1, ..., σ
2
p) where σ2

i is the variance

of the ith group for i = 1, ..., p. Then V̂ = diag(S2
1 , ..., S

2
p) where S2

i =
1

ni−1

∑ni

j=1(Yij − Y i0)
2 is the sample variance of the Yij . Hence the estimated

weights for FWLS are ŵij ≡ ŵi = 1/S2
i . Then the FWLS cell means model

has Y = Xcβc + e as in (5.1) except Cov(e) = diag(σ2
1, ..., σ

2
p).

Hence Z = U cβc + ε. Then UT
c U c = diag(n1ŵ1, ..., npŵp), (UT

c U c)
−1 =

diag(S2
1/n1, ..., S

2
p/np) = (XV̂

−1
XT )−1, and UT

c Z = (ŵ1Y10, ..., ŵpYp0)
T .

Thus
β̂FWLS = (Y 10, ..., Y p0)

T = β̂c.

That is, the FWLS estimator equals the one way ANOVA estimator of β
based on OLS applied to the cell means model. The ANOVA F test gener-
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alizes the pooled t test in that the two tests are equivalent for p = 2. The
FWLS procedure is also known as the Welch one way ANOVA and general-
izes the Welch t test. The Welch t test is thought to be much better than
the pooled t test. See Brown and Forsythe (1974ab), Kirk (1982, p. 100,
101, 121, 122),Welch (1947, 1951) and Problem 5.10.

In matrix form Z = U cβc + ε becomes⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

√
ŵ1Y1,1

...√
ŵ1Y1,n1√
ŵ2Y21

...√
ŵ2Y2,n2

...√
ŵpYp,1

...√
ŵpYp,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

=

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

√
ŵ1 0 0 . . . 0
...

...
...

...√
ŵ1 0 0 . . . 0
0

√
ŵ2 0 . . . 0

...
...

...
...

0
√

ŵ2 0 . . . 0
...

...
...

...

0 0 0 . . .
√

ŵp
...

...
...

...

0 0 0 . . .
√

ŵp

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

⎡
⎢⎢⎢⎣

μ1

μ2
...

μp

⎤
⎥⎥⎥⎦+

⎡
⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎢⎣

ε11
...

ε1,n1

ε21
...

ε2,n2

...
εp,1
...

εp,np

⎤
⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎥⎦

. (5.6)

Four tests for Ho : μ1 = · · · = μp can be used if Rule of Thumb 5.1:
max(S1, ..., Sp) ≤ 2min(S1, ..., Sp) fails. Let Y = (Y1, ..., Yn)

T , and let Y(1) ≤
Y(2) · · · ≤ Y(n) be the order statistics. Then the rank transformation of the
response is Z = rank(Y ) where Zi = j if Yi = Y(j) is the jth order statistic.
For example, if Y = (7.7, 4.9, 33.3, 6.6)T , then Z = (3, 1, 4, 2)T . The first test
performs the one way ANOVA F test with Z replacing Y . See Montgomery
(1984, p. 117-118). Two of the next three tests are described in Brown and
Forsythe (1974b). Let 	x
 be the smallest integer ≥ x, eg 	7.7
 = 8. Then
the Welch (1951) ANOVA F test uses test statistic

FW =

∑p
i=1 wi(Y i0 − Ỹ00)

2/(p − 1)

1 + 2(p−2)
p2−1

∑p
i=1(1 − wi

u
)2/(ni − 1)

where wi = ni/S
2
i , u =

∑p
i=1 wi and Ỹ00 =

∑p
i=1 wiY i0/u. Then the test

statistic is compared to an Fp−1,dW
distribution where dW = 	f
 and

1/f =
3

p2 − 1

p∑
i=1

(1 − wi

u
)2/(ni − 1).
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For the modified Welch (1947) test, the test statistic is compared to an
Fp−1,dMW

distribution where dMW = 	f
 and

f =

∑p
i=1(S

2
i /ni)

2∑p
i=1

1
ni−1

(S2
i /ni)2

=

∑p
i=1(1/wi)

2∑p
i=1

1
ni−1

(1/wi)2
.

Some software uses f instead of dW or dMW , and variants on the denominator
degrees of freedom dW or dMW are common.

The modified ANOVA F test uses test statistic

FM =

∑p
i=1 ni(Y i0 − Y 00)

2∑p
i=1(1 − ni

n
)S2

i

The test statistic is compared to an Fp−1,dM
distribution where dM = 	f


and

1/f =

p∑
i=1

c2
i /(ni − 1)

where

ci = (1 − ni

n
)S2

i /[

p∑
i=1

(1 − ni

n
)S2

i ].

The regpack function anovasim can be used to compare the five tests.

5.7 Problems

Problems with an asterisk * are especially important.

Output for Problem 5.1.

A B C D E

9.8 9.8 8.5 7.9 7.6 Analysis of Variance for Time

10.3 12.3 9.6 6.9 10.6 Source DF SS MS F P

13.6 11.1 9.5 6.6 5.6 Design 4 44.88 11.22 5.82 0.002

10.5 10.6 7.4 7.6 10.1 Error 25 48.17 1.93

8.6 11.6 7.6 8.9 10.5 Total 29 93.05

11.1 10.9 9.9 9.1 8.6
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5.1. In a psychology experiment on child development, the goal is to
study how different designs of mobiles vary in their ability to capture the
infants attention. Thirty 3-month-old infants are randomly divided into five
groups of six each. Each group was shown a mobile with one of five designs
A, B, C, D or E. The time that each infant spent looking at the design is
recorded in the output above along with the Anova table. Data is taken from
McKenzie and Goldman (1999, p. 234). Output is on the previous page.

a) Find μ̂2 = μ̂B .

b) Perform a 4 step Anova F test.

Output for Problem 5.2.

Variable MEAN SAMPLE SIZE GROUP STD DEV

NONE 10.650 4 2.0535

N1000 10.425 4 1.4863

N5000 5.600 4 1.2437

N10000 5.450 4 1.7711

TOTAL 8.0312 16 1.6666

One Way Analysis of Variance Table

Source df SS MS F p-value

Treatments 2 100.647 33.549 12.08 0.0006

Error 28 33.328 2.777

Total 15 133.974

Bonferroni Comparison of Means

Homogeneous

Variable Mean Groups

----------------------------

NONE 10.650 I

N1000 10.425 I

N5000 5.600 .. I

N10000 5.450 .. I

5.2. Moore (2000, p. 526): Nematodes are microscopic worms. A
botanist desires to learn how the presence of the nematodes affects tomato
growth. She uses 16 pots each with a tomato seedling. Four pots get 0

212



nematodes, four get 1000, four get 5000, and four get 10000. These four
groups are denoted by “none,” “n1000,” “n5000” and “n10000” respectively.
The seedling growths were all recorded and the table above is the one way
ANOVA results.

a) What is μ̂none?

b) Do a four step test for whether the four mean growths are equal.
(So Ho: μnone = μn1000 = μn5000 = μn10000.)

c) Examine the Bonferroni comparison of means. Which groups of means
are not significantly different?

5.3. According to Cobb (1998, p. 9) when the famous statistician W. G.
Cochran was starting his career, the experiment was to study rat nutrition
with two diets: ordinary rat food and rat food with a supplement. It was
thought that the diet with the supplement would be better. Cochran and his
coworker grabbed rats out of a cage, one at a time, and Cochran assigned
the smaller less healthy rats to the better diet because he felt sorry for them.
The results were as expected for the rats chosen by Cochran’s coworker, but
the better diet looked bad for Cochran’s rats.

a) What were the units?

b) Suppose rats were taken from the cage one at a time. How should the
rats have been assigned to the two diets?

5.4. Use the output from the command below

> sample(11)

[1] 7 10 9 8 1 6 3 11 2 4 5

to assign the following 11 people to three groups of size n1 = n2 = 4 and
n3 = 3.

Anver, Arachchi, Field, Haenggi, Hazaimeh,
Liu, Pant, Tosun, Yi, Zhang, Zhou

5.5. Sketch a good response plot if there are 4 levels with Y 10 = 2,
Y 20 = 4, Y 30 = 6, Y 40 = 7, and ni = 5.
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output for problem 5.6

level 1 2 3 4 5

15 percent 20 percent 25 percent 30 percent 35 percent

y1 y5 y2 y3 y4

9.8 10.8 15.4 17.6 21.6
—– —– —– —– —– —–

5.6. The tensile strength of a cotton nylon fiber used to make women’s
shirts is believed to be affected by the percentage of cotton in the fiber. The
5 levels of cotton percentage that are of interest are tabled on the last page.
Also shown is a (Tukey pairwise) comparison of means. Which groups of
means are not significantly different? Data is from Montgomery (1984. p.
51, 66).

output for problem 5.7

Source df SS MS F P

color 2 7.60 3.80 0.390 0.684

error 12 116.40 9.70

5.7. A researcher is interested in whether the color (red, blue or green)
of a paper maze effects the time to complete the maze.

a) State whether this is a random or fixed effects one way Anova. Explain
briefly.

b) Using the output above, perform the appropriate 4 step Anova F test.

A B C Output for problem 5.8.

9.5 8.5 7.7 Analysis of Variance for Time

3.2 9.0 11.3 Source DF SS MS F P

4.7 7.9 9.7 Design 2 49.168 24.584 4.4625 0.0356

7.5 5.0 11.5 Error 12 66.108 5.509

8.3 3.2 12.4

5.8. Ledolter and Swersey (2007, p. 49) describe a one way Anova design
used to study the effectiveness of 3 product displays (A, B and C). Fifteen
stores were used and each display was randomly assigned to 5 stores. The
response Y was the sales volume for the week during which the display was
present compared to the base sales for that store.

a) Find μ̂2 = μ̂B .

b) Perform a 4 step Anova F test.
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Figure 5.4: Graphical Anova for Problem 5.9

ganova(x,y)

smn -3.233326 -3.037367 6.270694

Treatments "A" "B" "C"

5.9. Ledolter and Swersey (2007, p. 49) describe a one way Anova design
used to study the effectiveness of 3 product displays (A, B and C). Fifteen
stores were used and each display was randomly assigned to 5 stores. The
response Y was the sales volume for the week during which the display was
present compared to the base sales for that store. Above is the Graphical
Anova plot found using the function ganova.

a) Which two displays (from A, B and C) yielded similar mean sales
volume?

b) Which effect (from A, B and C) appears to be significant?
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Problems using R/Splus.

Warning: Use the command source(“A:/regpack.txt”) to download
the programs, and source(“A:/regdata.txt”) to download the data. See
Preface or Section 17.1. Typing the name of the regpack function, eg
pcisim, will display the code for the function. Use the args command, eg
args(pcisim), to display the needed arguments for the function.

5.10. The pooled t procedures are a special case of one way Anova with
p = 2. Consider the pooled t CI for μ1−μ2. Let X1, ..., Xn1 be iid with mean μ1

and variance σ2
1. Let Y1, ..., Yn2 be iid with mean μ2 and variance σ2

2. Assume
that the two samples are independent (or that n1 + n2 units were randomly
assigned to two groups) and that ni → ∞ for i = 1, 2 in such a way that
ρ̂ = n1

n1+n2
→ ρ ∈ (0, 1). Let θ = σ2

2/σ
2
1, and let the pooled sample variance

S2
p = [(n1−1)S2

1 +(n2−1)S2
2 ]/[n1+n2−2] and τ 2 = (1−ρ+ρθ)/[ρ+(1−ρ)θ].

Then
X − Y − (μ1 − μ2)√

S2
1

n1
+

S2
2

n2

D→ N(0, 1)

and √
S2

1

n1
+

S2
2

n2

Sp

√
1
n1

+ 1
n2

X − Y − (μ1 − μ2)√
S2

1

n1
+

S2
2

n2

=
X − Y − (μ1 − μ2)

Sp

√
1
n1

+ 1
n2

D→ N(0, τ 2).

Now let θ̂ = S2
2/S

2
1 and τ̂ 2 = (1 − ρ̂ + ρ̂ θ̂)/(ρ̂ + (1 − ρ̂) θ̂). Notice that

τ̂ = 1 if ρ̂ = 1/2, and τ̂ = 1 if θ̂ = 1. The usual large sample (1 − α)100%
pooled t CI for (μ1 − μ2) is

X − Y ± tn1+n2−2,1−α/2 Sp

√
1

n1
+

1

n2
(5.7)

is valid if τ = 1. The large sample (1 − α)100% modified pooled t CI for
(μ1 − μ2) is

X − Y ± tn1+n2−4,1−α/2 τ̂ Sp

√
1

n1
+

1

n2
. (5.8)

The large sample (1 − α)100% Welch CI for (μ1 − μ2) is

X − Y ± td,1−α/2

√
S2

1

n1
+

S2
2

n2
(5.9)
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where d = max(1, [d0]), and

d0 =
(

S2
1

n1
+

S2
2

n2
)2

1
n1−1

(
S2

1

n1
)2 + 1

n2−1
(

S2
2

n2
)2

.

Suppose n1/(n1 + n2) → ρ. It can be shown that if the CI length is mul-
tiplied by

√
n1, then the scaled length of the pooled t CI converges in proba-

bility to 2z1−α/2

√
ρ

1−ρ
σ2

1 + σ2
2 while the scaled lengths of the modified pooled

t CI and Welch CI both converge in probability to 2z1−α/2

√
σ2

1 + ρ
1−ρ

σ2
2. The

pooled t CI should have coverage that is too low if

ρ

1 − ρ
σ2

1 + σ2
2 < σ2

1 +
ρ

1 − ρ
σ2

2 .

See Olive (2009b, Example 9.23).
a) Download the function pcisim.
b) Type the command

pcisim(n1=100,n2=200,var1=10,var2=1) to simulate the CIs for N(μi, σ
2
i )

data for i = 1, 2. The terms pcov, mpcov and wcov are the simulated coverages
for the pooled, modified pooled and Welch 95% CIs. Record these quantities.
Are they near 0.95?

5.11. From the end of Section 5.6, four tests for Ho : μ1 = · · · = μk can
be used if Rule of Thumb: max(S1, ..., Sk) ≤ 2min(S1, ..., Sk) fails. In R, get
the function anovasim. When H0 is true, the coverage = proportion of times
the test rejects H0 has a nominal value of 0.05. The terms faovcov is for the
usual F test, modfcov is for a modified F test, wfcov is for the Welch test,
mwfcov for the modified Welch test and rfcov for the rank test. The function
generates 1000 data sets with k = 4, ni = ni = 20, mi = μi and sdi = σi.

a) Get the coverages for the following command. Want the coverages to
be near or less than 0.05. Are they? anovasim(m1 = 0, m2 = 0, m3 = 0, m4
= 0, sd1 = 1, sd2 = 1, sd3 = 1, sd4 = 1)

b) Get the coverages for the following command. Are the coverages near
or less than 0.05? anovasim(m1 = 0, m2 = 0, m3 = 0, m4 = 0, sd1 = 1, sd2
= 2, sd3 = 3, sd4 = 4)

c) Now use the following command where H0 is false. Want the coverages
near 1. Are they?
anovasim(m1 = 1, m2 = 0, m3 = 0, m4 = 1)
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5.12. This problem uses data from Kuehl (1994, p. 128).
a) Get regdata and regpack into R. Type the following commands. Then
simultaneously press the Ctrl and c keys. In Word use the menu command
“Edit>Paste.” Print out the figure.

y <- ycrab+1/6

aovtplt(crabhab,y)

b) From the figure, what response transformation should be used: Y =
1/Z, Y = 1/

√
Z, Y = log(Z), Y =

√
Z, or Y = Z?

5.13. The following data set considers the number of warp breaks per
loom, where the factor is tension (low, medium or high).

a) Type the following commands:

help(warpbreaks)

out <- aov(breaks ~ tension, data = warpbreaks)

out

summary(out)

plot(out$fit,out$residuals)

title("Residual Plot")

Highlight the ANOVA table by pressing the left mouse key and dragging
the cursor over the ANOVA table. Then use the menu commands “Edit>
Copy.” Enter Word and use the menu commands “Edit>Paste.”

b) To place the residual plot in Word, get into R and click on the plot,
hit the Ctrl and c keys at the same time. Enter Word and use the menu
commands “Edit>Paste.”

c) Type the following commands:

warpbreaks[1,]

plot(out$fit,warpbreaks[,1])

abline(0,1)

title("Response Plot")

Click on the response plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”
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5.14. Obtain the Box, Hunter and Hunter (2005, p. 134) blood coagu-
lation data from (www.math.siu.edu/olive/regdata.txt) and the R program
ganova from (www.math.siu.edu/olive/regpack.txt). The program does
graphical Anova for the one way Anova model.

a) Enter the following commands and include the plot in Word by si-
multaneously pressing the Ctrl and c keys, then using the menu commands
“Copy>Paste” in Word.

ganova(bloodx,bloody)

The scaled treatment deviations are on the top of the plot. As a rule
of thumb, if all of the scaled treatment deviations are within the spread of
the residuals, then population treatment means are not significantly different
(they all give response near the grand mean). If some deviations are outside of
the spread of the residuals, then not all of the population treatment means are
equal. Box, Hunter and Hunter (2005, p. 137) state ‘The graphical analysis
discourages overreaction to high significance levels and avoids underreaction
to “very nearly” significant differences.’

b) From the output, which two treatments means were approximately the
same?

c) To perform a randomization F test in R, get the program rand1way

from (www.math.siu.edu/olive/regpack.txt). and type the following com-
mands. The output z$rdist is the randomization distribution, z$Fpval is the
pvalue of the usual F test, and z$randpval is the pvalue of the randomized F
test.

z<-rand1way(y=bloody,group=bloodx,B=1000)

hist(z$rdist)

z$Fpval

z$randpval

d) Include the histogram in Word.
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One Way Anova in SAS

To get into SAS, often you click on a SAS icon, perhaps something like
The SAS System for .... A window with a split screen will open. The top
screen says Log-(Untitled) while the bottom screen says Editor-Untitled1.
Press the spacebar and an asterisk appears: Editor-Untitled1*.

For problem 5.15, consider saving your file as hw5d15.sas on your diskette
(A: drive). (On the top menu of the editor, use the commands “File > Save
as”. A window will appear. Use the upper right arrow to locate “31/2 Floppy
A” and then type the file name in the bottom box. Click on OK.) From the
top menu in SAS, use the “File> Open” command. A window will open. Use
the arrow in the NE corner of the window to navigate to “31/2 Floppy(A:)”.
(As you click on the arrow, you should see My Documents, C: etc, then 31/2
Floppy(A:).) Double click on hw5d15.sas.

This point explains the SAS commands. The semicolon “;” is used to
end SAS commands and the “options ls = 70;” command makes the output
readable. (An “*” can be used to insert comments into the SAS program.
Try putting an * before the options command and see what it does to the
output.) The next step is to get the data into SAS. The command “data
clover;” gives the name “clover” to the data set. The command “input strain
$ nitrogen @ @;” says the first entry is variable strain and the $ means
it is categorical, the second variable is nitrogen and the @@ means read 2
variables, then 2, ..., until the end of the data. The command “cards;” means
that the data is entered below. Then the data in entered and the isolated
semicolon indicates that the last case has been entered.

The commands “proc glm; class = strain; model nitrogen = strain;” tells
SAS to perform one way Anova with nitrogen as the response variable and
strain as the factor.

5.15. Cut and paste the SAS program from
(www.math.siu.edu/olive/sasreg.txt) for 5.15 into the SAS Editor.

To execute the program, use the top menu commands “Run>Submit”.
An output window will appear if successful.

(If you were not successful, look at the log window for hints on errors.
A single typo can cause failure. Reopen your file in Word or Notepad and
make corrections. Occasionally you can not find your error. Then find your
instructor or wait a few hours and reenter the program.)

Data is from SAS Institute (1985, p. 126-129). See Example 5.6.
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a) In SAS, use the menu commands “Edit>Select All” then “Edit>Copy.”
In Word, use the menu commands “Edit>Paste.” Highlight the first page of
output and use the menu commands “Edit>Cut.” (SAS often creates too
much output. These commands reduce the output from 4 pages to 3 pages.)

You may want to save your SAS output as the file HW5d15.doc on your
disk.

b) Perform the 4 step test for Ho μ1 = μ2 = · · · = μ6.

c) From the residual and response plots, does the assumption of equal
population standard deviations (σi = σ for i = 1, ..., 6) seem reasonable?

One Way Anova in ARC

5.16. To get in ARC, you need to find the ARC icon. Suppose the ARC icon
is in a math progs folder. Move the cursor to the math progs folder, click
the right mouse button twice, move the cursor to ARC, double click, move the
cursor to ARC, double click. These menu commands will be written “math
progs > ARC > ARC.” To quit ARC, move cursor to the x in the northeast
corner and click.

This Cook and Weisberg (1999, p. 289) data set contains IQ scores on
27 pairs of identical twins, one raised by foster parents IQf and the other
by biological parents IQb. C gives the social class of the biological parents:
C = 1 for upper class, 2 for middle class and 3 for lower class. Hence the
Anova test is for whether mean IQ depends on class.

a)Activate twins.lsp dataset with the menu commands
“File > Load > Data > ARCG > twins.lsp”.

b) Use the menu commands “Twins>Make factors”, select C and click
on OK. The line “{F}C Factor 27 Factor–first level dropped” should appear
on the screen.

c) Use the menu commands “Twins>Description” to see a description of
the data.

d) Enter the menu commands “Graph&Fit>Fit linear LS” and select
{F}C as the term and IQb as the response. Highlight the output by pressing
the left mouse key and dragging the cursor over the output. Then use the
menu commands “Edit> Copy.” Enter Word and use the menu commands
“Edit>Paste.”

e) Enter the menu commands “Graph&Fit>Boxplot of” and enter IQb in
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the selection box and C in the Condition on box. Click on OK. When the
boxplots appear, click on the Show Anova box. Click on the plot, hit the
Ctrl and c keys at the same time. Enter Word and use the menu commands
“Edit>Paste.” Include the output in Word. Notice that the regression and
Anova F statistic and p-value are the same.

f) Residual plot: Enter the menu commands “Graph&Fit>Plot of,” select
“L1:Fit-Values” for the “H” box and “L1:Residuals” for the “V” box, and
click on “OK.” Click on the plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”

g) Response plot: Enter the menu commands “Graph&Fit>Plot of,” se-
lect “L1:Fit-Values” for the “H” box and “IQb” for the “V” box, and click
on “OK.” When the plot appears, move the OLS slider bar to 1 to add the
identity line. Click on the plot, hit the Ctrl and c keys at the same time.
Enter Word and use the menu commands “Edit>Paste.”

h) Perform the 4 step test for Ho μ1 = μ2 = μ3.

One Way Anova in Minitab

5.17. a) In Minitab, use the menu command “File>Open Worksheet”
and double click on Baby.mtw. A window will appear. Click on “OK.”

This McKenzie and Goldman (1999, p. T-234) data set has 30 three
month old infants randomized into five groups of 6 each. Each infant is
shown a mobile of one of five multicolored designs, and the goal of the study
is to see if the infant attention span varies with type of design of mobile. The
times that each infant spent watching the mobile are recorded.

b) Choose “Stat>Basic Statistics>Display Descriptive Statistics,” select
“C1 Time” as the “Variable,” click the “By variable” option and press Tab.
Select “C2 Design” as the “By variable.”

c) From the window in b), click on “Graphs” the “Boxplots of data”
option, and “OK” twice. Click on the plot and then click on the printer icon
to get a plot of the boxplots.

d) Select “Stat>ANOVA>One-way,” select “C1-time” as the response
and “C2-Design” as the factor. Click on “Store residuals” and click on “Store
fits.” Then click on “OK.” Click on the output and then click on the printer
icon.

e) To make a residual plot, select “Graph>Plot.” Select “Resi1” for “Y”
and “Fits1” for “X” and click on “OK.” Click on the plot and then click on
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the printer icon to get the residual plot.
f) To make a response plot, select “Graph>Plot.” Select “C1 Time” for

“Y” and “Fits1” for “X” and click on “OK.” Click on the plot and then click
on the printer icon to get the response plot.

h) Do the 4 step test for Ho μ1 = μ2 = · · · = μ5.

To get out of Minitab, move your cursor to the “x” in the NE corner of
the screen. When asked whether to save changes, click on “no.”
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